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บทที ่1 

บทนํา 

1.1. ความเป็นมาและความสําคญัของปัญหา 
ปัจจุบันมีการรณรงค์ให้ช่วยกันปิดเคร่ืองใช้ไฟฟ้าในช่วงเวลาพักกลางวัน เพื่อให้เกิด           

การประหยดัพลงังาน ทางบริษทั เอเซียกรุ๊ป (1999) จาํกดั จึงมีนโยบายให้พนักงานภายในบริษทั 

ช่วยกันปิดเคร่ืองปรับอากาศในช่วงเวลาพกักลางวนั เพื่อให้เกิดการประหยดัพลงังาน และลด

ค่าใชจ่้ายในการดาํเนินงานของบริษทั แต่เน่ืองจากการควบคุมการเปิด/ปิดเคร่ืองปรับอากาศของ

บริษทัในปัจจุบนันั้น จะถูกควบคุมโดยพนกังานภายในบริษทัโดยการเดินไปใชรี้โมทสั่งการท่ีหนา้

เคร่ืองปรับอากาศ ซ่ึงบางคร้ังไม่สะดวกสบายและไม่คล่องตวั และบริษทั เอเซียกรุ๊ป (1999) จาํกดั 

มีหลายสาขาอยูห่่างไกลกนั ทาํใหย้ากต่อการติดตามนโยบายการประหยดัพลงังานของบริษทั 

ดังนั้ นคณ ะผู ้จัดทําจึงได้นําทักษะความรู้ท่ีได้จากการเข้าร่วมสหกิจศึกษา ณ  สถาน

ป ระก อบ ก ารม าป ระยุก ต์ใช้ใน ก ารจัด ทําโค รงงาน  เร่ือง ระบ บ แส ด งผลแล ะควบ คุ ม

เคร่ืองปรับอากาศภายในสํานักงาน (Display and control of air conditioner by IOT) เพื่อให้บริษทั  

มี Air Monitor ไวใ้ช้ในกาสั่งเปิด/ปิดเคร่ืองปรับอากาศได้ ผ่านหน้าจอ Mobile Application และ 

Web Application และเพื่อให้การติดตามนโยบายการประหยดัพลงังานของบริษทัเป็นไปไดอ้ยา่งมี

ประสิทธิภาพ นอกจากน้ี ยงัเป็นระบบต้นแบบช่วยให้บริษัทนําไปพัฒนาต่อยอดใช้งานกับ

เคร่ืองจกัรอ่ืนๆในบรัษทัไดใ้นอนาคต 

 

1.2. วตัถุประสงค์ของโครงงาน 

1.2.1. เพื่ออาํนวยความสะดวกในการเปิด/ปิดเคร่ืองปรับอากาศของบริษทั 

1.2.2. เพื่อใหก้ารติดตามนโยบายการประหยดัพลงังานของบริษทัเป็นไดอ้ยา่งมีประสิทธิภาพ 

1.2.3. เพื่อพฒันาระบบใหน้าํไปใชต่้อยอดไดใ้นอนาคต 
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1.3. ขอบเขตของโครงงาน 

1.3.1. ตอ้งติดตั้งอุปกรณ์ท่ีหนา้เคร่ืองปรับอากาศ 

1.3.2. จาํเป็นตอ้งมีไฟเล้ียงตวัอุปกรณ์ 

1.3.3. จาํเป็นตอ้งมีการเช่ือมต่อผา่น Internet 

1.3.4. มีการเกบ็ขอ้มูลลงในฐานขอ้มูล 

1.3.5. มีการแสดงอุณหภูมิและความช้ืนของเคร่ืองปรับอากาศแต่ละเคร่ือง 

1.3.6. สามารถสัง่เปิด/ปิดเคร่ืองปรับอากาศได ้1 เคร่ือง 

1.3.7. ใชง้านดว้ยซอฟตแ์วร์บน Mobile Application และ Web Application 

 

1.4. ประโยชน์ทีค่าดว่าจะได้รับ 

1.4.1. ช่วยอาํนวยความสะดวกในการเปิด/ปิดเคร่ืองปรับอากาศของบริษทั 

1.4.2. ช่วยใหก้ารติดตามนโยบายการประหยดัพลงังานของบริษทัเป็นไดอ้ยา่งมีประสิทธิภาพ 

1.4.3. สามารถนาํระบบไปพฒันาต่อยอดไดใ้นอนาคต 



บทที ่2 

ทฤษฏีทีเ่กีย่วข้อง 

2.1 Arduino 

Arduino เป็นภาษาอิตาลีวา่ อาดุอีโน่ หรือ อาดุยโน่  Arduino คือ Open-Source Platform 

สาํหรับการสร้างตน้แบบทางอิเล็กทรอนิกส์ โดยมีจุดมุ่งหมายให้ Arduino Platform เป็น Platform 

ท่ีง่ายต่อการใชง้าน โดย Arduino Platform มี 2 ประเภท 

- ส่วนทีเ่ป็นฮาร์ดแวร์ (Hardware) 

บอร์ดอิเล็กทรอนิกส์ขนาดเล็ก ท่ีมีไมโครคอนโทรลเลอร์ (MCU) เป็นช้ินส่วนหลกั   

ถูกนาํมาประกอบร่วมกบัอุปกรณ์อิเล็กทรอนิกส์อ่ืน ๆ เพื่อให้ง่ายต่อการใชง้าน หรือท่ีเรียกกนัว่า 

บอร์ด Arduino, โดยบอร์ด Arduino เองก็มีหลายรุ่นให้เลือกใช ้โดยมีความแตกต่างกนัในเร่ืองของ

ขนาด หรือสเปค เช่น จาํนวนของขารับส่งสัญญาณ, แรงดนัไฟท่ีใช,้ และประสิทธิภาพของ MCU 

เป็นตน้ 

- ส่วนทีเ่ป็นซอฟต์แวร์ (Software) 

ซอฟต์แวร์ท่ีใช้ในกาํรพฒันางาน สําหรับบอร์ด Arduino นั่นคือโปรแกรมท่ีเรียกว่า 

Arduino IDE ในกาํรเขียนโปรแกรมและคอมไพล์ลงบอร์ด โดย ขนําดของโปรแกรม Arduino   

โดยปกติแลว้จะใหญ่กว่าโคด้ AVR ปกติเน่ืองจาํกโคด้ AVR เป็นกาํรเข ํ้าถึงจาํก รีจิสเตอร์โดยตรง 

แต่โค้ด Arduino เข้าถึงผ่านฟังก์ชั่น  เพื่อให้สํามารถเขียนโค้ดได้ง ํ่ ายมํากกว่าการเขียนโค้ด          

แบบ AVR หรือเวอร์ชัน่อ่ืน ๆ ของ Arduino 

2.2 NodeMCU 

NodeMCU (โหนด เอ็มซียู) คือ บอร์ดคลา้ย Arduino ท่ีสามารถเช่ือมต่อกับ WiFi ได ้

สามารถเขียนโปรแกรมดว้ย Arduino IDE ไดเ้ช่นเดียวกบั Arduino และบอร์ดก็มีราคาถูกมาก ๆ 

เหมาะแก่ผู ้ท่ี คิดจะเร่ิมต้นศึกษา หรือทดลองใช้งานเก่ียวกับ Arduino, IoT, อิ เล็กทรอนิกส์          

หรือแมแ้ต่การนาํไปใชจ้ริงในโปรเจคต่างๆ กต็าม เพราะราคาไม่แพง 

ภายในบอร์ดของ NodeMCU ประกอบไปด้วย ESP8266 (ไมโครคอนโทรลเลอร์         

ท่ีสามารถเช่ือมต่อ WiFi ได้) พร้อมอุปกรณ์อาํนวยความสะดวกต่าง ๆ เช่น พอร์ต micro USB
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สําหรับจ่ายไฟและอพัโหลดโปรแกรม, ชิพสําหรับอพัโหลดโปรแกรมผ่านสาย USB, ชิพแปลง

แรงดนัไฟฟ้า และขาสาํหรับเช่ือมต่ออุปกรณ์ภายนอก เป็นตน้ 

 

รูปท่ี 2.1 บอร์ด NodeMCU ESP8266 

2.3 DHT11 

Dht11 คือ โมดูลหรือเซ็นเซอร์สําหรับวดัอุณหภูมิและความช้ืนในอากาศ ซ่ึงจะมีอยู ่     

2 แบบ คือ แบบท่ีมาเป็นโมดูล และแบบท่ีมีแต่เซ็นเซอร์ โดยการรับส่งขอ้มูล จะใชส้ายสัญญาณ

เสน้เดียวและเป็นสญัญาณแบบดิจิตอล 

คุณสมบัติ   

- ใชแ้รงดนัไฟฟ้า 3 - 5V 

- ใชก้ระแสไฟฟ้าสูงสุด 2.5mA 

- เหมาะสาํหรับวดัความช่ืนระดบั  20-80% โดยมีความผดิพลาดไม่เกิน 5%  

- เหมาะสาํหรับวดัอุณหภูมิ  0-50°C  โดยมีความผดิพลาดไม่เกิน ±2°C 

- ความถ่ีในการวดั 1 Hz   

- ขนาด 15.5mm x 12mm x 5.5mm 

- ขา 4 pins ใชพ้ื้นท่ีในการวางขา 0.1" 



5 
 

2.4 Visual Studio Code 

 

รูปท่ี 2.1 โปรแกรม Visual Studio Code 

Visual Studio Code ห รือ VSCode เป็ น โป รแกรม  Code Editor ท่ี ใช้ใน การแก้ไข      

และปรับแต่งโค้ด จากค่ายไมโครซอฟท์ มีการพัฒนาออกมาในรูปแบบของ OpenSource จึง

สามารถนาํมาใชง้านไดแ้บบฟรี ๆ ท่ีตอ้งการความเป็นมืออาชีพ 

ซ่ึง Visual Studio Code เหมาะสําหรับนักพัฒนาโปรแกรมท่ีต้องการใช้งานข้าม

แพลตฟอร์ม รองรับการใชง้านทั้งบน Windows, macOS และ Linux สนบัสนุนทั้งภาษา JavaScript, 

TypeScript และ Node.js สามารถเช่ือมต่อกับ Git ได้ นํามาใช้งานได้ง่ายไม่ซับซ้อน มีเคร่ืองมือ

ส่วนขยายต่าง ๆ ดงัน้ี  

1.การเปิดใชง้านภาษาอ่ืน ๆ เช่น ภาษา C++, C#, Java, Python, PHP หรือ Go  

2.Themes 

3.Debugger  

4.Commands  

ความแตกต่างระหวา่ง VSCode และ Visual Studio คือ  

- VSCode ไดท้าํการตดัในส่วนของ GUI designer ออกไป เหลือแต่เพียงตวั Editor 

เท่านั้น จึงทาํใหต้วัโปรแกรมนั้นค่อนขา้งเบากวา่ Visual Studio เป็นอยา่งมาก 

- VSCode สามาถนาํมาใชง้านไดฟ้รี รองรับการทาํงานขา้มแพลตฟอร์ม 

http://mindphp.com/%E0%B8%84%E0%B8%B9%E0%B9%88%E0%B8%A1%E0%B8%B7%E0%B8%AD/73-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3/2091-opensource-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3.html
http://mindphp.com/%E0%B8%84%E0%B8%B9%E0%B9%88%E0%B8%A1%E0%B8%B7%E0%B8%AD/73-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3/2124-windows-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3.html
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2.5 Firebase 

 

รูปท่ี 2.2 Firebase 

Firebase คือ Project ท่ีถูกออกแบบมาให้เป็น API และ Cloud Storage สําหรับพฒันา 

Realtime Application รองรับหลาย Platform ทั้ง IOS App, Android App, Web App 

บริการท่ีเลือกใช ้

Database แบบ Realtime 

ฐานขอ้มูล Firebase Realtime เป็นฐานขอ้มูลแบบ Cloud-hosted ขอ้มูลจะถูกเก็บเป็น JSON 

และซิงโครไนส์ในแบบเรียลไทม์กับทุกไคลเอ็นต์ท่ีเช่ือมต่อ เม่ือผูใ้ช้สร้างแอปพลิเคชันข้าม

แพลตฟอร์มดว้ย SDK ของ iOS, Android และ JavaScript เกบ็และซิงคข์อ้มูลกบัฐานขอ้มูล NoSQL 

cloud ของเรา ขอ้มูลจะซิงคก์บัผูใ้ชท้ั้งหมดในแบบเรียลไทมแ์ละยงัสามารถใชง้านไดเ้ม่ือแอปของ

ผูใ้ชอ้อฟไลน ์

- Realtime ฐานข้อมูล Firebase Realtime จะใช้การซิงโครไนซ์ข้อมูลทุกคร้ังท่ี มีการ

เปล่ียนแปลงขอ้มูลอุปกรณ์ใด ๆ ท่ีเช่ือมต่อ 

- Offline Firebase ยงัสามารถตอบสนองได้แม้ในขณะออฟไลน์ เน่ืองจากฐานข้อมูล 

Firebase Realtime Database SDK ยงัคงมีขอ้มูลของผูใ้ชไ้ปยงัดิสก ์

- เข้าถึงได้จากอุปกรณ์ไคลเอ็นต์  ฐานขอ้มูล Firebase Realtime สามารถเขา้ถึงไดโ้ดยตรง

จากโทรศพัทมื์อถือหรือเวบ็เบราเซอร์ไม่จาํเป็นตอ้งมีเซิร์ฟเวอร์แอ็พพลิเคชนั ความปลอดภยัและ

การตรวจสอบความถูกตอ้งของขอ้มูลสามารถดูไดจ้ากกฎความปลอดภยัฐานขอ้มูล 

- ปรับขนาดข้ามฐานข้อมูลหลายแห่ง สามารถรองรับขอ้มูลของแอพพลิเคชัน่ของผูใ้ชไ้ด้

ตามความตอ้งการ โดยแยกขอ้มูลของผูใ้ช้ออกจากอินสแตนซ์ฐานขอ้มูลหลายแห่งในโครงการ 

Firebase เดียวกนั 
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2.6 Infrared 

อินฟราเรด หรือ I.R. คือ รูปแบบการติดต่อส่ือสารขอ้มูลโดยใชค้ล่ืนแสงอินฟราเรด มี

ลกัษณะการส่ือสารคลา้ยกบัการส่ือสารดว้ยคล่ืนไมโครเวฟกล่าวคือการส่ือสารดว้ยแสงอินฟราเรด

จะตอ้งหนัตวัรับและตวัส่งใหต้รงกนัและไม่มีส่ิงกีดขวาง เส้นสายตา (Line-of-sight) หรือขวางแสง

อินฟราเรด การส่ือสารดว้ยวิธีน้ีใชไ้ดใ้นระยะทางท่ีไม่ไกลนกัในปัจจุบนัมีคอมพิวเตอร์และอุปกรณ์

มากมายท่ีสามารถใชค้ล่ืนแสงอินฟราเรดน้ีส่ือสารขอ้มูลกนัได ้เช่นคอมพิวเตอร์  โนต้บุค๊   

คอมพิวเตอร์แบบพกพา เมาส์ คียบ์อร์ด เป็นตน้ ซ่ึงเคร่ืองคอมพิวเตอร์และอุปกรณ์ดงักล่าวจะตอ้งมี

พอร์ตท่ีเรียกวา่ “IrDA” ท่ีมีไวเ้ป็นช่องสาํหรับต่อพว่งอุปกรณ์ประเภทใชแ้สง 

- ไดโอดเปล่งแสงอินฟราเรด (IR LED) และวงจรตวัส่ง 

ไดโอดเปล่งแสงอินฟราเรดหรือ IR LED เป็นอุปกรณ์สาํคญัของตวัส่ง ให้แสงในช่วง

คล่ืนอินฟราเรด (มองดว้ยตาเปล่าไม่เห็น) และให้ความเขม้แสงสูงสุดท่ีเฉพาะค่าความถ่ีเท่านั้น 

LED ประเภทน้ีมีลกัษณะเหมือน LED ทัว่ไป มี 2 ขา คือ แอโนด กบั แคโทด ดงันั้นการต่อใชง้าน ก็

เหมือนกรณี LED ทัว่ไป LED ท่ีให้แสงอินฟราเรดแต่ละชนิด สามารถทนกระแสสูงสุด (mA) ได้

แตกต่างกนั 

 

รูปท่ี 2.3 Infrared led 

- ไอซีรับแสงอินฟราเรด (IR Receiver) และวงจรตวัรับ 

อุปกรณ์ ตัวรับสําห รับแสงอิน ฟ ราเรด เช่น  รุ่น  TSOP4838 ของบริษัท  Vishay 

Semiconductor ทาํงานในลักษณะคล้ายโฟโต้ทรานซิสเตอร์ (Phototransistor) มี 3 ขา คือ OUT, 

GND, VCC (ขาหมายเลข 1,2,3 ตามลาํดบั) สามารถใชก้บัแรงดนั 5V ได ้เม่ือไดรั้บแสงอินฟราเรด 

จะให้เอาต์พุตเป็น LOW แต่ถา้ไม่ได้รับแสง จะให้เอาต์พุตเป็น HIGH เพื่อป้องกันแสงรบกวน 

อุปกรณ์ประเภทน้ี ไดถู้กออกแบบมาใชง้านสาํหรับแสงอินฟราเรดท่ีเป็นสัญญาณแบบ Pulse Train 

ความถ่ี เช่น 38kHz 
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รูปท่ี 2.4 Infrared Receiver 

2.7 HTML 

HTML คือ ภาษาหลกัท่ีใช้ในการเขียนเว็บเพจ โดยใช้ Tag ในการกาํหนดการแสดงผล 

HTML ย่อมาจากคาํว่า Hypertext Markup Language โดย Hypertext หมายถึง ขอ้ความท่ีเช่ือมต่อ

กนัผ่านลิงค ์(Hyperlink) Markup language หมายถึงภาษาท่ีใช ้Tag ในการกาํหนดการแสดงผลส่ิง

ต่าง ๆ ท่ีแสดงอยูบ่นเวบ็เพจ ดงันั้น HTML จึงหมายถึง ภาษาท่ีใช ้Tag ในการกาํหนดการแสดงผล

เวบ็เพจท่ีต่างกเ็ช่ือมถึงกนัใน Hyperspace ผา่น Hyperlink 

2.8 JavaScript 

JavaScript คือ ภาษาคอมพิวเตอร์สาํหรับการเขียนโปรแกรมบนระบบอินเทอร์เน็ต ท่ีกาํลงั

ไดรั้บความนิยมอย่างสูง Java JavaScript เป็น ภาษาสคริปต์เชิงวตัถุ ท่ีเรียกกนัว่า สคริปต์ (script) 

ซ่ึงในการสร้างและพฒันาเวบ็ไซต ์ใชร่้วมกบั HTML เพื่อให้เวบ็ไซตดู์มีการเคล่ือนไหว สามารถ

ตอบสนองผูใ้ชง้านไดม้ากข้ึน ซ่ึงมีวิธีการทาํงานในลกัษณะ แปลความและดาํเนินงานไปทีละคาํสั่ง 

(interpret) หรือเรียกว่า อ็อบเจ็กโอเรียลเต็ด (Object Oriented Programming) ท่ีมีเป้าหมายในการ 

ออกแบบและพฒันาโปรแกรมในระบบอินเทอร์เน็ต สําหรับผูเ้ขียนด้วยภาษา HTML สามารถ

ทาํงานขา้มแพลตฟอร์มได ้โดยทาํงานร่วมกบั ภาษา HTML และภาษา Java ไดท้ั้งทางฝ่ังไคลเอนต ์

(Client) และ ทางฝ่ังเซิร์ฟเวอร์ (Server)  

 



บทที ่3 

รายละเอยีดการปฏิบัตงิาน 

3.1 ช่ือและทีต่ั้งของสถานประกอบการ 

ช่ือสถานประกอบการ : บริษทั เอเซีย กรุ๊ป (1999) จาํกดั 

ทีต่ั้งสถานประกอบการ : ตั้งอยูท่ี่ 757 หมู่10 ถนนพระราม 2 แขวงบางมด เขต    

จอมทองกรุงเทพมหานคร 10150 

เวบ็ไซต์ : http://www.asiagroup1999.com/ 

หมายเลขโทรศัพท์ : 0-2453-1941-9 

 

รูปท่ี 3.1 แผนท่ีตั้งสถานประกอบการ 

3.2 ลกัษณะการประกอบการ ผลติภัณฑ์การให้บริการหลกัขององค์กร 

จาํหน่ายและติดตั้ง ผลิตภณัฑค์อนกรีตอดัแรงสาํเร็จรูป   

3.3 รูปแบบการจัดองค์การและการบริหารงานขององค์กร 

กรรมการผูจ้ดัการมี 1 คน และรองกรรมการผูจ้ดัการมี 3 คน 



10 
 

 

 

 

 

รูปท่ี 3.2 แผนผงัองคก์ร
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3.4 ตําแหน่งและลกัษณะงานทีนั่กศึกษาได้รับมอบหมาย 

 ช่ือ - นามสกลุ นายธนากร  จวงเจิม 

 แผนก ITS 

 ตาํแหน่ง ผูช่้วยโปรแกรมเมอร์ 

 ลกัษณะงาน วิจยัและพฒันาแอพพลิเคชัน่เพื่อใชใ้นองคก์ร 

 ช่ือ - นามสกลุ นายพศวตั  ไกลศรีสมบติั 

 แผนก ITS 

 ตาํแหน่ง ผูช่้วยโปรแกรมเมอร์ 

 ลกัษณะงาน วิจยัและพฒันาแอพพลิเคชัน่เพื่อใชใ้นองคก์ร 

3.5 ช่ือและตําแหน่งงานของพนักงานทีป่รึกษา 

 ช่ือ – นามสกลุ คุณรุ่งโรจน์  ลาสุวรรณ    

 ตาํแหน่ง โปรแกรมเมอร์ 

 E – mail l_RUNGROT@ASIAGROUP1999.CO.TH 

3.6 ระยะเวลาทีป่ฏิบัตงิาน 

• ระยะเวลาในการปฏิบติังาน 16 สปัดาห์ 

• ตั้งแต่วนัท่ี 14 พฤษภาคม พ.ศ. 2561 ถึงวนัท่ี 31 สิงหาคม พ.ศ. 2561 

• วนัเวลาในการปฏิบติังานวนัจนัทร์ – เสาร์ เวลา 08.00 – 17.00 น. 

3.7 ขั้นตอนและวธีิการดําเนินงาน 

3.7.1 ดําเนินการส่วน Hardware 

3.7.1.1 จดัเตรียมอุปกรณ์ 

3.7.1.2 ทดลองต่อวงจรบน Breadboard 

 

รูปท่ี 3.3 ต่อวงจรลงบน Breadboard 
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รูปท่ี 3.4 วงจรเสร็จสมบูรณ์ 

3.7.2 ดําเนินการส่วน Software ตดิตั้งโปรแกรม 

3.7.2.1 ติดตั้งโปรแกรม Arduino IDE 

3.7.2.2 ติดตั้งโปรแกรม Visual Studio Code 

3.7.2.3 ติดตั้งโปรแกรม Xampp 

3.7.2.4 เร่ิมตน้การใชง้าน Firebase Realtime Database         

สาํหรับรายละเอียดทั้งหมด นาํเสนอในบทท่ี 4                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                     

3.7.3 ดําเนินการเขียนโปรแกรม 

ออกแบบหนา้จอและคาํสัง่การทาํงาน ของ Web/Mobile Application โดยใชโ้ปรแกรม 

Visual Studio Code และใชโ้ปรแกรม xampp ในการจาํลอง Web Server และเขียนโคด้คาํสัง่

การทาํงานของบอร์ด NodeMCU โดยใชโ้ปรแกรม Arduino IDE และเช่ือมต่อโครงงานกบั 

Firebase 

3.7.4 ทดสอบระบบ 

นาํระบบไปทดสอบกบัเคร่ืองปรับอากาศในหอ้งประชุม 

3.7.5 จัดทาํเอกสาร 

จดัทาํเอกสารโครงงานทั้งหมดโดยใชโ้ปรแกรม Microsoft Word 

3.7.6 นําเสนอโครงงาน 

จดัทาํส่ือนาํเสนอโครงงานโดยใชโ้ปรแกรม Microsoft Powerpoint 
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ตารางที ่3.1 แสดงขั้นตอนและระยะเวลาการดําเนินงาน 

ขั้นตอนการดาํเนินงาน พ.ค. 61 มิ.ย. 61 ก.ค. 61 ส.ค. 61 ก.ย. 61 

1. ดาํเนินการส่วนของ Hardware      

2. ดาํเนินการส่วนของ Software 

ติดตั้งโปรแกรม 

     

3. ดาํเนินการเขียนโปรแกรม      

4. ทดสอบระบบ      

5. จดัทาํเอกสาร      

6. นาํเสนอโครงงาน      

 

3.8 อุปกรณ์และเคร่ืองมือทีใ่ช้ 

3.8.1 ฮาร์ดแวร์ 

− NodeMCU    1 ตวั 

− Sensor DHT11    1 ตวั 

− Infrared LED    1 ตวั 

− VS1838B    1 ตวั 

− LED Red    1 ตวั 

− Resistor 330 ohm   1 ตวั 

3.8.2 ซอฟตแ์วร์ 

− Arduino IDE 

− Visual Studio Code 

− PhoneGap 

− Firebase 



บทที ่4 

ผลการปฏิบตังิานตามโครงงาน 

4.1 ขั้นตอนการติดตั้งโปรแกรม 

- Arduino IDE 

 

รูปท่ี 4.1 หนา้จอ Arduino Setup:License Agreement 

กด I Agree เพือ่ยอมรับ 

 

รูปท่ี 4.2 หนา้จอ Arduino Setup:Installation Option 

หนา้จอสาํหรับตวัเลือกการติดตั้ง กด Next เพื่อไปยงัหนา้ Installation Folder 
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รูปท่ี 4.3 หนา้จอ Arduino Setup:Installation Folder 

เลือกท่ีจดัเกบ็โปรแกรม จากนั้นกด Install 

 

รูปท่ี 4.4 หนา้จอ Arduino Setup:Install program 

 ทาํการ Install โปรแกรม 

 

รูปท่ี 4.5 หนา้จอ Arduino Setup:Install Completed 

 Install เสร็จส้ิน 
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รูปท่ี 4.6 หนา้จอโปรแกรม Arduino IDE 

 ในหนา้ต่างโปรแกรม Arduino IDE คลิกไปท่ีเมนู File -> Preferences เพื่อติดตั้งบอร์ด 

NodeMCU/ESP8266 แบบออนไลน์ 

 

รูปท่ี 4.7 หนา้จอ Preferences 

 เพิ่ม http://arduino.esp8266.com/stable/package_esp8266com_index.json ลงในช่อง 

Additional Boards Manager URLs จากนั้นกด OK 
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รูปท่ี 4.8 หนา้จอ Boards Manage 

 คลิกไปท่ีเมนู Tools -> Board -> Board Manager จากนั้นพิมพค์าํว่า ESP8266 ลงในช่อง 

และเร่ิมตน้ติดตั้ง 

 

รูปท่ี 4.9 หนา้จอ Add file zip 

 ดาวนโ์หลด Library firebase จาก https://github.com/googlesamples/firebase-

arduino/archive/master.zip แลว้เพิ่มเขา้ไปใน Arduino IDE  

โดยเขา้ไปท่ี Sketch -> Include Library -> Add .ZIP Library 
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รูปท่ี 4.10 หนา้จอ Library Manager 

ติดตั้ง Library โดยเขา้ไปท่ี Sketch -> Include Library -> Library Manager โดยใหติ้ดตั้ง 

ดงัน้ี 

- Adafruit Unified Sensor 

- Arduino Uno WiFi Dev Ed Library 

- ArduinoJson 

- DHT sensor library 

- IRremote 

- IRremoteESP8266 

- Visual Studio Code 

 

รูปท่ี 4.11 หนา้จอ Setup Visual Studio Code 

 กด Next  
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รูปท่ี 4.12 หนา้จอ License Agreement 

 กด Next  

 

รูปท่ี 4.13 หนา้จอ Select Destination 

 เลือกท่ีจดัเกบ็โปรแกรม จากนั้นกด Next 

 

รูปท่ี 4.14 หนา้จอ Select Start Menu 

 กด Next 
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รูปท่ี 4.15 หนา้จอ Select Additional Tasks 

กด Next 

 

รูปท่ี 4.16 หนา้จอ Ready to Install 

 กด Install 

 

รูปท่ี 4.17 หนา้จอ Install 

 ทาํการ Install  
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รูปท่ี 4.18 หนา้จอ Install Complete 

 Install เสร็จส้ิน 

 

รูปท่ี 4.19 หนา้จอโปรแกรม Visual Studio Code 

 สามารถเลือก New file หรือ Open folder เพื่อเร่ิมใชง้านไดเ้ลย 
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- Xampp 

 

รูปท่ี 4.20 หนา้จอ Setup Xampp 

เร่ิมการติดตั้งกด Next 

 

รูปท่ี 4.21 หนา้จอ Select Components 

เลือก Components ท่ีตอ้งการติดตั้งจากนั้นกด Next 
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รูปท่ี 4.22 หนา้จอ Installation Folder 

เลือกท่ีจดัเกบ็โปรแกรมจากนั้นกด Next 

 

รูปท่ี 4.23 หนา้จอ Bitnami for xampp 

เลือกติดตั้ง Bitnami เพิ่มจากนั้นกด Next 

 

รูปท่ี 4.24 หนา้จอ Ready to Install 

 กด Install 
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รูปท่ี 4.25 หนา้จอ Install 

 ทาํการ Install โปรแกรม 

 

รูปท่ี 4.26 หนา้จอ Install Finish 

 Install เสร็จส้ิน 

 

รูปท่ี 4.27 หนา้จอ Select Language 

 เลือกภาษาเพื่อเร่ิมตน้การใชง้านโปรแกรม 
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รูปท่ี 4.28 หนา้จอโปรแกรม xampp 

 

รูปท่ี 4.29 หนา้จอโปรแกรม xampp 

 ทาํการเปล่ียนท่ีอยูข่องไฟลง์านท่ีจะใชง้านโดยเขา้ไปท่ี Config ของ Apache -> 

Apache(httpd.conf) 

 

รูปท่ี 4.30 หนา้จอ Notepad httpd.conf 

เปล่ียนท่ีอยูไ่ฟลง์านใน DocumentRoot และ Directory หลงัจากนั้นทาํการ save 
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รูปท่ี 4.31 หนา้จอโปรแกรม xampp 

เปิดการทาํงาน Apache 

- Firebase 

 

รูปท่ี 4.32 หนา้เวบ็ Firebase 

เขา้เวป็ Firebase และทาํการ Sign In 
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รูปท่ี 4.33 หนา้เวบ็ Log in 

Sign In ดว้ย Gmail 

  

รูปท่ี 4.34 หนา้เวบ็ Firebase 

เม่ือ Sign In เรียบร้อยไปท่ี GO TO CONSOLE 
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รูปท่ี 4.35 หนา้เวบ็เม่ือเร่ิมการทาํงาน 

เขา้มาท่ี Console ทาํการสร้างโครงการ 

 

รูปท่ี 4.36 หนา้เวบ็การเพิ่มโครการ 

กรอกช่ือโครงการ เลือกภูมิภาค 
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รูปท่ี 4.37 หนา้เวบ็การเพิ่มโครการ 

ยอมรับเง่ือนไข และสร้างโครงการ 

 

รูปท่ี 4.38 หนา้เวบ็เร่ิมตน้ใชง้าน Firebase 

จากรูปท่ี 4.38 

1. การเช่ือมต่อ Firebase หรือนาํไปใชใ้นโครงการรูปแบบต่าง ๆ เช่น App iOS, App 

Android, Web App เป็นตน้ 

2. ส่วนพฒันา Database 

3. ส่วนพฒันา Storage 

4. ไปท่ีเอกสาร เก่ียวกบัการใชง้าน Firebase เช่น 

- การเร่ิมตน้ใชง้าน Firebase กบัโครงการ 

- การใชง้าน database 

1 2

3

4 
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รูปท่ี 4.39 หนา้เวบ็ส่วนโคด้การติดตั้ง SDKs 

ทาํการ Copy 

 

รูปท่ี 4.40 หนา้จอโปรแกรม VS code 

นาํมาใส่ใน Project  
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รูปท่ี 4.41 หนา้เวบ็ การเร่ิมใชง้านDatabase 

การใชง้าน Database เลือกใชแ้บบ Realtime, คล๊ิกท่ีสร้างฐานขอ้มูล 

 

รูปท่ี 4.42 หนา้เวบ็การเร่ิมใชง้าน Database 

กฎความปลอกภยั เร่ิมใชใ้นโหมดทดสอบ, เปิดใช ้Realtime Database 

 

รูปท่ี 4.43 หนา้เวบ็ Database 
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รูปท่ี 4.44 หนา้เวบ็ Database 

แสดงตวัอยา่งขอ้มูลใน Realtime Database 



 

 

บทที ่5 

สรุปผลและข้อเสนอแนะ 

5.1 สรุปผลโครงงาน 

5.1.1 สรุปผลโครงงาน 

  คณะผูจ้ ัดทาํได้จัดทาํโครงงานเร่ืองระบบแสดงผลและควบคุมเคร่ืองปรับอากาศ

ภายในสํานักงาน โครงงานน้ีพฒันาให้กบับริษทั เอเซียกรุ๊ป (1999) จาํกดั เพื่อพฒันาการใชง้าน

เคร่ืองปรับอากาศภายในสาํนกังาน ให้สามารถเปิดปิดเคร่ืองปรับอากาศไดท้ั้งในและนอกสถานท่ี

ด้วยโทรศพัท์มือถือ โดยใช้เคร่ืองมือ ด้าน Hardware ใช้ NodeMCU ESP8266, DHT11, Infrared 

LED ส่วนทางด้าน Softwareใช้โปรแกรม Visual Studio Code, Arduino IDE และเป็นการศึกษา

แนวคิดทางดา้น IOT (Internet of Things) เพื่อให้สามารถประยกุตใ์ชก้บัเคร่ืองจกัรอ่ืนๆของบริษทั 

เอ เ ซียก รุ๊ป (1999)  จํากัด  โดยได้ประโยชน์ คือ  ช่วยอํานวยความสะดวกในการเปิดปิด

เคร่ืองปรับอากาศให้กบัพนักงานในบริษทั, ผูบ้ริหารบริษทัสามารถติดตามนโยบายการประหยดั

พลงังานจากบริษทัสาขาอ่ืนท่ีอยู่ห่างไกลกนัได,้ บริษทัสามารถนาํระบบไปพฒันาต่อยอดใชก้บั

เคร่ืองจกัรอ่ืนๆไดใ้นอนาคต 

5.1.2 ข้อจํากดัหรือปัญหาของโครงงาน 

5.1.2.1  ปัญหาเร่ืองเวลา เพราะเวลามีจาํกดัจะทาํใหเ้กิดการเรียนรู้งานอยา่งไม่เตม็ท่ี 

5.1.2.2  ปัญหาเร่ืองการใชอุ้ปกรณ์ เพราะนกัศึกษายงัไม่มีความรู้เก่ียวกบัอุปกรณ์ท่ีใช ้

จึงจาํเป็นตอ้งใชเ้วลาในการเรียนรู้ 

5.1.2.3  ปัญหาเร่ืองขั้นตอนการดาํเนินงาน ควรปรึกษาผูท่ี้มีความรู้มากกว่า จะช่วยลด  

ระยะเวลาไดเ้ป็นอยา่งมาก 

5.1.3     ข้อเสนอแนะ 

5.1.3.1  ควรศึกษาอุปกรณ์ต่างๆใหมี้ความชาํนาญก่อนออกฝึกสหกิจ 

5.1.3.2  ควรมีการวางแผนท่ีดีในการทาํโครงงานเพราะเวลาจะมีจาํกดั 

5.1.3.3  ควรสอบถามหรือปรึกษากบัพนักงานพี่เล้ียง จะทาํให้ไม่เสียเวลาในการทาํ

โครงงานผดิพลาด 

  



34 

 

5.2. สรุปผลการปฏิบัติงานสหกจิศึกษา 

 5.2.1 ข้อดีของการปฏบิัติงานสหกจิศึกษา 

5.2.1.1   ช่วยเสริมสร้างทกัษะในการทาํงานร่วมกบัผูอ่ื้น  

5.2.1.2   ช่วยทาํใหมี้ความรับผดิชอบต่อหนา้ท่ีท่ีไดรั้บมอบหมาย 

5.2.1.3   ช่วยทาํใหมี้ระเบียบวินยั,ตรงต่อเวลาในการทาํงาน 

5.2.1.4   ไดรั้บรู้ถึงปัญหาและวิธีการแกไ้ขในการทาํงาน 

5.2.1.5   ไดอ้อกไปปฏิบติังานนอกสถานท่ี จึงทาํใหมี้ประสบการณ์ 

5.2.2 ปัญหาทีพ่บของการปฏิบัตงิานสหกจิศึกษา 

5.2.2.1   นกัศึกษายงัไม่มีความรู้ท่ีเพียงพอต่อการใชอุ้ปกรณ์ต่างๆ 

5.2.2.2   นกัศึกษายงัไม่ทราบถึงกระบวนการทาํงานในการปฏิบติังานจริง 

5.2.2.3   ความรู้ท่ีมียงัไม่เพียงพอต่อการทาํงาน 

 5.2.3 ข้อเสนอแนะ  

5.2.3.1  ควรจดัตารางหรือวางแผนงานท่ีจะทาํใหดี้ 

5.2.3.2  ควรตรวจสอบงานท่ีสาํเร็จแลว้ทุกคร้ัง เพื่อดูขอ้ผดิพลาดท่ีเกิดข้ึน 

5.2.3.3  ควรมีการอบรมหรือการฝึกสอนใหน้กัศึกษามีความรู้ใหเ้พียงพอต่อการ 

      ใชอุ้ปกรณ์ เช่น NodeMCU ESP8266  เป็นตน้ 
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ภาคผนวก ก 

ภาพแสดงการทาํงานของระบบ 

 

รูปท่ี ก.1 แสดงการทาํงานบน Web 

 

รูปท่ี ก.2 แสดงการทาํงานบน Mobile 
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ภาคผนวก ข 

ภาพระหวา่งการปฏิบติังาน 

 

รูปท่ี ข.1 ขณะปฏิบติังานต่อวงจร 

 

รูปท่ี ข.2 ขณะปฏิบติังานต่อวงจร 
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รูปท่ี ข.3 ขณะปฏิบติังานเขียนโปรแกรม 

 

รูปท่ี ข.4 ขณะปฏิบติังานทดสอบระบบกบัเคร่ืองปรับอากาศในหอ้งประชุม 
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รูปท่ี ข.5 ขณะปฏิบติังานทดสอบระบบบน Web Application 
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